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Eclipse Interface for Use with StarShip Overview 
Eclipse Interface for Use with StarShip is a companion product that automates all aspects of 
shipment processing, such as rating, labeling, tracking, and reporting. Once you enter an Eclipse 
sales or work order number, StarShip retrieves the ship-to name, ship-to address, purchase order 
number, ship via, and more. You can also use StarShip to analyze costs, monitor outbound 
activity, and identify trends using standard or user-defined reports. 

StarShip handles all major carriers such as United Parcel Service (UPS), FedEx, Airborne 
Express, RPS, and United States Postal Service (USPS). StarShip transmits package information 
electronically by writing freight charges back to your ledger, so you can invoice orders as you 
ship. Access to UPS and RPS databases reduces labor costs, and provides immediate tracking 
information. Using an electronic manifest for all orders avoids wasted time shuffling paper. With 
StarShip, anyone in your organization can access shipping information without interrupting 
shipment processing, allowing quick response to customer inquiries. 

Features and functions of StarShip include the following: 

• Improves shipping accuracy. You can use barcode scanners and electronic scales to enter 
the sales order number and parcel weight.  

• Writes freight charges and shipment details, such as the tracking number, for each 
package back to the order. Freight charge write back can include a customizable handling 
fee.  

• Alerts customers, using activity triggers, when a shipment has been processed in 
conjunction with the Outbound E-mail companion product. 

• Accelerates billing. You can invoice orders as you ship without having to re-enter 
shipping information. 

• Improves customer service. You can retrieve shipping information from the web site or 
any networked terminal. 

• Increases shipping flexibility and lowers costs with multi-carrier support. Available 
carriers include: UPS, FedEx, USPS, Airborne, Spee-Dee and User-Defined.  

• Maintains carrier compliancy. Print carrier-approved shipping labels on thermal label 
printers, such as Eltron or Zebra. 

• Provides shipping reports. Use standard and custom reports to analyze costs and monitor 
outbound activity. 
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StarShip Setup Overview 
Once StarShip is installed, you need to set up the program to recognize the carriers with which 
you do business and set up the scale and printers attached to the system. 

• Company Information and Preferences 
Follow the General Setup instructions in the StarShip User's Guide for entering 
information about your company, COD deliveries, printing, archiving, and other 
miscellaneous preferences. 

• Third Party Insurance 
To enter third party insurer information for the carriers you use, follow the General Setup 
instructions in the StarShip User's Guide. 

• Scale 
Before using an attached scale, follow the Electronic Scale Setup instructions in the 
StarShip User's Guide. 

• Printers 
For the printers you use, follow the Printer Setup instructions in the StarShip User's 
Guide. 

You can print thermal bar-coded shipping labels for UPS Domestic, FedEx Ground, 
USPS, and Spee-Dee shipments. For all other carriers, StarShip prints to airbills and 
waybills on a dot-matrix printer.  

• Carriers 
For each carrier you use, follow the setup instructions in the StarShip User's Guide. 

• Shipping Address Information 
StarShip uses the customer address information stored in the Eclipse system to print 
shipping labels for packages sent to Eclipse customers. 

To enter additional shipping addresses in StarShip, follow the Add Records to the 
Customer List instructions in the StarShip User's Guide. 

See Also: 

Setting Up Eclipse for StarShip Overview 



Rel. 8.6.2 (Eterm) Eclipse Interface for Use with StarShip 

© 2007  Activant Solutions Inc. All rights reserved. 3 

Setting Up Eclipse for StarShip Overview 
Before you can use StarShip with the Eclipse system, you need to set up the following 
information: 

• Control Maintenance Records – Use the StarShip control maintenance records to define 
your system defaults for applying and posting StarShip charges. 

• Ship Vias – Create ship vias for the StarShip carriers and services you use. 

• Shipping URLs – To access tracking information on the carrier's web site from the 
Eclipse system, store the carrier's web site address. 

• Customer Records – For each customer whose orders you ship using StarShip, enter 
shipping-related information for the freight carriers they use. 

See Also: 

StarShip Overview 
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Control Maintenance Records for StarShip  
Following are the control maintenance records used for StarShip. 

Control Maintenance Records 
Set the following control maintenance records: 

• Apply Extra Handling For Shipping To First Gen Only 

• Apply Misc StarShip Charges To Freight Or Handling 

• Apply StarShip Handling Charges To Freight Or Handling 

• Apply StarShip/Clippership Frght To Expense Frght If Cust Frght Exmt 

• Extra Handling Charge For Shipping 

• Post Charges From StarShip 

• Post Shipping Freight On Return P/Os 

• Print Status Override from StarShip 

Note: If you set the Post Charges From StarShip control maintenance record to N, 
the remaining control maintenance records have no effect. 

See Also: 
Setting Up Eclipse for StarShip Overview 
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Setting Up Ship Vias for StarShip 
Assign keywords to the system ship vias that use StarShip carriers. The StarShip program uses 
these keywords to determine how to process the shipment. 

To set up ship vias for StarShip: 

1. From the Maintenance menu, select Ship Via to display the Ship Via Maintenance 
screen. 

2. In the Ship Via/New field, select the ship via to set up for StarShip. 

3. Use the Freight hot key to display the Freight Data screen. 

4. Complete the freight data fields to set up automatic freight and handling charges and 
enter surcharge information. 

5. In the StarShip / Clippership Keywords field, enter the appropriate shipping keywords 
for the ship via. Leave a space between each entry, but do not use commas. 

The following table lists keywords recognized by StarShip.  

Select the row that describes the shipping method and enter one word from each Key 
column in this field.  

Input Value 

Key 1 Key 2 Key 3 

 
Interpreted as... 

USA 

UPS (DEFAULT)  UPS Ground 

UPS  3, THREE, ORANGE  UPS 3rd Day 

UPS  2, SECOND, BLUE   UPS 2nd Day Air 

UPS 2, SECOND, BLUE  AM UPS 2nd Day A.M. 

UPS  1, NEXT, RED  SAV UPS Next Day Saver 

UPS 1, NEXT, RED  UPS Next Day  

UPS  LETTER, LTR  UPS Next Day Letter 

UPS   LETTER, LTR SAT  UPS Next Day Letter, Saturday 
Delivery 

USPS (DEFAULT)  Parcel Post 

USPS  PRIORITY   USPS Priority 

USPS   PF  USPS Priority Flat 

USPS  1ST, FIRST  USPS 1st Class 

USPS  EXPRESS   USPS Express 

USPS  LETTER, LTR  USPS Letter 

USPS  BOOK, 4, SP   USPS Media Mail 

USPS BOUND  USPS Bound Printed Matter 
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Input Value 

Key 1 Key 2 Key 3 

 
Interpreted as... 

FEDEX  G  FedEx Ground 

FEDEX  XPR  FedEx Express Saver 

FEDEX  2, TWO, ECON   FedEx Second Day 

FEDEX  (DEFAULT)  FedEx Standard Overnight 

FEDEX STANDARD  FedEx Standard Overnight 

FEDEX  PRIORITY   FedEx Priority Overnight 

FEDEX 1ST, FIRST  FedEx First Overnight 

FEDEX  LETTER, LTR   FedEx Standard Letter 

FEDEX  LETTER, LTR  PRIORITY  FedEx Priority Letter 

AIRBORNE 2, TWO, SECOND, 
SELECT 

 Airborne Second Day 

AIRBORNE NEXT, AFTER  Airborne Next Afternoon 

AIRBORNE (DEFAULT)  Airborne Express 

Canada 

UPS  (DEFAULT)  UPS Standard 

UPS  EXPEDITE, BLUE  UPS Expedited 

UPS  AIR, RED, EXPRESS  UPS Express 

FEDEX (DEFAULT)  FedEx Ground 

International 

UPS  (DEFAULT)  UPS Expedited 

UPS  EXPRESS, RED  UPS Express 

USPS PP SURFACE, PARCEL 
POST, ECONOMY 

 Parcel Post Economy 

USPS PP AIR, PARCEL POST 
AIR, AIRMAIL 

 Parcel Post Airmail 

USPS LP SURFACE, LETTER 
POST ECONOMY 

 Letter Post Economy 

USPS LP AIR, LETTER POST 
AIR 

 Letter Post Airmail 

USPS PUBLISH, PERIODICAL  Publishers' Periodicals 

USPS EXPRESS  Global Express Mail 

USPS PRIORITY  Global Priority Mail 

FEDEX  (DEFAULT)  FedEx Priority Overnight 

FEDEX 2, ECON  FedEx Economy 

AIRBORNE (DEFAULT)  EXPRESS 

USPS Options 
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Input Value 

Key 1 Key 2 Key 3 

 
Interpreted as... 

  DC Deliver Confirmation 

  RRM Return Receipt for 
Merchandise 

  RD Restricted Delivery 

  SH Special Handling 

  CERTIFIED Certified Mail 

  REGISTERED Registered Mail 

  RETURN Return Receipt 

 

Note: You can add EARLY to any service. 

6. Save the settings and exit the Ship Via Maintenance window. 

See Also: 

Setting Up Eclipse for StarShip Overview 
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Maintaining Shipping URLs for StarShip 
From the Header screen in sales order entry you can use the Shipping hot key to access a web 
site and check the status of an order that shipped using a StarShip carrier. 

To access the tracking information on the carrier's web site, the system uses the address stored 
for that carrier in Shipping URL Maintenance and the tracking number stored in the order's 
change log. When a StarShip carrier changes their web site access to tracking information, you 
need to update the information stored in Shipping URL Maintenance. 

Use the following tasks to maintain shipping URL information: 

• Update shipping URLs. 

• Edit the components of a URL address. 

To update shipping URLs: 

1. From the Tools menu, select Shipping URL Maintenance to display the Shipping URL 
Maintenance screen. 

2. In the URL ID field, do one of the following: 

• To edit an ID, press F10 and select the ID to edit. 

• To create an ID, press F10 and select New. At the Enter new ID prompt, type an ID 
up to 8 characters and press Enter. 

The screen displays the following fields of information for the URL ID. If you are 
creating a new ID, enter the following information for the URL. 

Field Description 
Description Description of the web site the URL ID accesses. 

Default URL URL address that accesses the web site home page. For example, 
www.eclipseinc.com accesses the Eclipse home page. If you select options on that 
page, such as Company, the URL changes to include additional information to 
access the different pages of the site. 
Press Enter to copy the default URL to the Web URL field, where you can add 
additional information to the link. If you change the default URL, the system 
automatically updates the default portion of the URL in the Web URL field. 

Web URL URL address that accesses the tracking information on the web site. The base URL 
is the URL indicated in the Default URL field. 
To edit the components of the URL address, use the Web URL Maintenance hot 
key. For example, if you want to access a specific page on a website, add that 
information to the base URL in this field. 

3. To delete a URL ID, use the Delete hot key. At the prompt, type delete to confirm the 
deletion. 

4. Press Esc to save the updated information. 
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To edit the components of a URL address: 

1. From the Tools menu, select Shipping URL Maintenance to display the Shipping URL 
Maintenance screen. 

2. In the URL ID field, press F10 and select the ID to edit. 

3. Use the Web URL Maintenance hot key to display the URL ID Maintenance screen. 

4. Edit the following fields, as needed: 

Field Description Example 
URL Path to the web site home page. http://www.usps.com 

Protocol Directory path from the home page to the tracking 
information. 

cttgate/ontrack.cgi 

Variables Placeholders in the URL path for variable data. tracknbr 

Values The values to assign to the corresponding variables. $TRACK.NO$ 

5. Press Esc to save the updated information and return to the Shipping URL Maintenance 
screen. 

You can also insert components into the Web URL field by placing your cursor where 
you want to add the component, pressing F10 and selecting the component to add. The 
system adds the component to the URL. 

See Also: 

Setting Up Eclipse for StarShip Overview 
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Setting Up Customer Records for StarShip 
If you use StarShip to ship orders to customers, enter shipping-related information in the 
customer records. 

To set up a customer record for StarShip: 

1. From the Files menu, select Customer to display the Customer Maintenance screen. 

2. In the Customer/New field, enter the customer name to display their record. 

3. Complete the Freight In Exempt (Y/N) and Freight Out Exempt (Y/N) fields. 

Note: If an order is  freight exempt, the system overrides the setting in StarShip 
and does not add the freight amount to a COD amount. If an order is not 
freight exempt the system does not override the setting in StarShip. 

4. If the customer shipping address is a residential address, use the Add'l Info hot key and 
then the Freight Data hot key to enter Y in the Residential Address field. 

The Eclipse system displays a Y in the Residential Shipping Address field on the 
Additional Header Information screen in Sales Order Entry for this customer. The Y in 
this field on the sales order directs StarShip to apply a residential shipping fee to the 
customer's freight charge. 

5. If the customer has their own relationship with freight carriers, who bill them directly for 
their freight charges, use the Add'l Info hot key and then the Freight Data hot key to 
enter the following default freight data: 

• In the Insurance Required field, indicate whether the carrier requires insurance. 

• On the Account Number column, enter the customer's account number with the 
carrier. 

6. To apply the extra handling charge specified in the Extra Handling Charge For Shipping 
control maintenance record to outgoing billable freight on orders shipped to this 
customer, do the following: 

• Use the Add'l Info hot key and then the Misc Cust Info hot key to display the 
Miscellaneous Customer Information screen.  

• Set the value in the StarShip Extra Handling Charge? (Y/N) field to Y.  

• Press Esc to return to the Customer Maintenance screen. 

7. Press Esc to save the updated record. 

See Also: 
StarShip Setup Overview 



Rel. 8.6.2 (Eterm) Eclipse Interface for Use with StarShip 

© 2007  Activant Solutions Inc. All rights reserved. 11 

StarShip Shipments Overview 
During the course of a day you weigh packages for shipment and enter the appropriate 
information for each one. The system then prints the label for you to affix to the package. The 
StarShip online help provides information about the fields on the shipment processing windows. 

When the carrier picks up the packages being shipped, you close the current manifest and print a 
label, which the carrier scans, signs, and returns to you for filing. 

The following tasks provide a quick overview of the steps you need to process shipments: 

• Processing Shipments 

• Processing International Shipments 

• Adding Multiple Packages to One Shipment 

• Making Changes to Shipments 

• Setting Up a Global Default Handling Charge 

• Reprinting a Pickup Summary Label and Report 

• Closing the Current Manifest 

See Also: 

StarShip Overview 
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Processing Domestic StarShip Shipments 
Use the Process Shipments - Current Manifest window to enter package delivery information for 
domestic shipments.  

To process domestic StarShip shipments: 

1. From the StarShip main menu, display the Ship-StarShip-Current Manifest window in 
one of the following ways: 

• From the Do menu, select Ship.  

• Click the Ship button. 

2. Click the New icon to display the New Shipment window. 

3. In the Document field select Eclipse as Server. 

Note: You only need to do this the first time you use StarShip. 

4. In the Key field, enter the sales or work order number. For example, enter S0059532.001 
and click Continue. 

The system populates the shipping window with information from the order. The system 
populates the carrier and service based on the ship via assigned to the order. 

Note: If you are shipping a package that is not associated with an order, you can 
enter the customer ID preceded by a period. For example, enter .59532. 
The system populates the shipping window with information from the 
customer record. 

5. Check that the recipient and sender information is correct. 

Note: A check mark in the Residential check box for a recipient indicates that the 
shipment is going to a residential address. If you always ship to a 
residential address for a designated customer, you can set up this flag in the 
customer record. 

6. Check that the correct carrier and service are selected. 

7. Enter a check mark in the Scale check box and place the package on the scale connected 
to your PC. 

The system populates the Weight field with the package weight. 

Note: If you do not have an electronic scale connected to your PC, you can enter 
the weight. 

8. Enter any other required shipment and package options. 

If you set up a global default handling charge, the system populates the Shipment Options 
tab with the default. 
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The system populates the following fields using data from the sales order: 

• COD – If the order is COD in Eclipse, the system flags the C.O.D. check box on the 
Package Options tab. If the customer uses Eclipse Credit Card Authorization and the 
generation that is shipping has a credit card pre-authorization, the C.O.D. box is not 
checked. 

• Hazardous Materials – If a product on the order is assigned a hazard class, the 
system flags the Hazardous check box on the Package Options tab for all packages 
in the shipment. Remove the flag for all non-hazardous packages. 

• Shipping Instructions – The system populates the Detail tab in the upper right area 
of the window with the shipping instructions entered on the Header screen of the 
order. 

9. To add multiple packages to the shipment, click Next and repeat steps 7 and 8. 

10. To declare a value for the shipment, enter the declared value in the Insured Value field. 

Double-click the Declared Value... button to have the system configure and display the 
insurance charge. 

11. Copy the Customer ID on the Recipient tab to the Invoice # field on the Reference tab. 

12. Click Save. 

The StarShip system prints the package label and returns the rate information to the 
Eclipse system. The Eclipse system records the freight and handling charges on the 
Totals screen of the sales order and records the shipping details in the change log 
accessed from the order Header screen. 

See Also: 

StarShip Shipments Overview 
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Processing International StarShip Shipments 
Use the International tab on the Process Shipments - Current Manifest window, to enter package 
delivery information for international shipments.  

To process international StarShip shipments: 

1. From the StarShip main menu, display the Ship-StarShip-Current Manifest window in 
one of the following ways: 

• From the Do menu, select Ship.  

• Click the Ship button. 

2. On the Recipient tab, in the Country field, select the country to which you are shipping. 

The system adds the International tab to that section of the window. Depending upon the 
carrier you use to send your international shipment, the fields on the tab will vary. 

3. Complete the International tab fields required for your shipment. 

If your company does not normally make international shipments, do the following: 

• In the SED Filed field, select UPS Prepared. Click the Browse button to display the 
Commercial Invoice window, select the Export Information Code, and click OK.  

• In the Certificate of Origin field, select UPS Prepared. 

Note: For more information regarding International shipments, please refer to 
your StarShip User's Guide. You can find this information in the Shipping 
section, under International Shipments. 

4. Complete the rest of the order as you would for a domestic shipment. 

See Also: 
StarShip Shipments Overview 
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Adding Multiple Packages to One StarShip Shipment 
After processing the first package in a shipment, you can add multiple packages to it. 

To add multiple packages to one StarShip shipment: 

1. Process the heaviest package in the shipment, but do not click Save. 

2. Click Next. 

The Current Manifest window re-displays in edit mode.  

The number of the next package in the shipment displays. For example, Pkg 2 of 2. 

The customer information stays intact, but any weight, declared value, COD, or options 
information is cleared so you can enter the information that pertains to the next package 
in this shipment. 

Note: To review packages, use the Prev, Next, First, and Last buttons. 

See Also: 

StarShip Shipments Overview 

Processing Domestic StarShip Shipments 
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Making Changes to StarShip Shipments 
Before you close the current manifest, it is possible to make changes to StarShip shipments. 
StarShip does not allow users to reship an item on the same day. 

Note: If the Eclipse information for the shipment has changed, you must delete 
the shipment from the StarShip database and then reprocess the order 
through Eclipse. 

To make a change to a StarShip shipment: 

1. From the StarShip main menu, display the Ship-StarShip-Current Manifest window in 
one of the following ways: 

• From the Do menu, select Ship.  

• Click the Ship button. 

2. Click the New icon to display the New Shipment window. 

3. In the Key field, enter the order number followed by the word FORCE. For example, 
enter S0059532.001FORCE and click Continue. 

The system populates the shipping window with information from the sales order.  

4. Make necessary changes, such as adding or deleting packages or changing shipment 
options. 

5. To delete the shipment from the StarShip database, click the Delete button at the top of 
the window. 

6. Click Save. 

The StarShip system prints the package label and returns the rate information to the 
Eclipse system. The Eclipse system adds the rate information to the change log associated 
with the header of the order. 
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Setting Up Global Default Handling Charges in 
StarShip 
Set up global default handling charges in StarShip.  

If the charge is per shipment or dependent on the ship via, configure the charge in Eclipse. 

To set up a global default handling charge: 

1. From the StarShip main menu, display the Ship-StarShip-Current Manifest window in 
one of the following ways: 

• From the Do menu, select Ship.  

• Click the Ship button. 

2. On the bottom right area of the window, click the Ship Options tab. 

3. In the Handling Fee check box, enter a check mark to display the handling fee options. 

4. Select and enter one of the following handling fee formulas: 

• Flat rate per shipment. 

• Flat rate per package. 

• Percentage of freight. When you select this option, you can also enter minimum and 
maximum handling fees.  

• Minimum – If the calculated handling fee is less than the minimum, the system 
charges the minimum amount. 

• Maximum – If the calculated handling fee is greater than the maximum, the 
system charges only the maximum amount. 

5. From the File menu, select Save Defaults. 

6. Close StarShip. 

The next time you open StarShip, the settings you just configured will load as defaults. 

See Also: 
StarShip Shipments Overview 
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Reprinting StarShip Pickup Summary Labels and 
Reports 
Use the following procedure if you need to reprint the pickup summary label and report. 

To reprint a StarShip pickup summary label and report: 

1. From the StarShip main menu, display the Ship-StarShip-Current Manifest window in 
one of the following ways: 

• From the Do menu, select Ship.  

• Click the Ship button. 

2. From the Carriers > UPS menu, select UPS OnLine History. 

3. Click the date to reprint. 
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Closing the Current Manifest in StarShip 
When a carrier picks up the day's shipments, you need to close the current manifest for those 
shipments. This process transmits the package information to the carrier's web site and prints a 
summary label. After the carrier scans the bar code and signs the label, store it with your records. 

To close the current manifest in StarShip: 

1. From the StarShip main menu, display the Close Current Manifest window in one of the 
following ways: 

• From the Do menu, select Close. 

• Click the Close button. 

2. Select the carriers to close.  

By default, the system selects any carriers for which you have shipped packages. The 
area on the right side displays the summary counts. Click the Totals or By Service tabs 
to view shipment totals for that carrier or by service. 

3. Click any of the following buttons, as needed: 

• Manifest – Prints a manifest report. 

• Forms – Displays the Print Shipping Forms window, where you can batch print 
forms such as labels, COD tags, and waybills. 

• 3rd Party Ins – Prints a report that shows the amount insured by a third party insurer 
associated with the selected carrier. 

4. Click the Post button to display the Post Shipments window.  

5. To select the information to include in the history file for the displayed manifest, click the 
Setup Export button. 

6. To specify the printer on which to print a copy of the manifest, click the Printer Setup 
button.  

7. Click the Start button.  

The system does the following: 

• Uploads package level details to the carrier's web site. 

• Clears the current shipment files for the next day’s shipments. 

• Changes the label on the Start button to Exit. 

Note: Before editing a closed manifest to add a package, enable the Auto Print 
Enabled During Edit option on the Setup > Preferences > AutoPrint 
tab. Otherwise, no label prints after you add the additional package. 
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StarShip Reporting 
Use standard and custom reports to analyze costs and monitor outbound activity. You can send 
all reports to a printer or file. 

Standard Reports 
From the Reports menu, you can select the following standard reports: 

• Insurance Report – Total fees, carrier's rate, and premium due to be sent with check to 
insurer. 

• COD Remittance – Outstanding COD shipments. 

• Shipment History by Customer – Shipment history by customer for a designated carrier 
and date range. 

When you run this report, the Print Reports dialog box prompts you to enter the number 
of copies, date range, and carrier. 

• Daily Shipments by Customer – Daily shipments by customer for a date range. 

When you run this report, the Print Reports dialog box prompts you to enter the number 
of copies. 

• Freight Reports: 

• History – Revenue history by date range and carrier. 

• Daily – Daily freight report. 

To generate a standard report, follow the Print Reports instructions in the StarShip User's Guide.  

Custom Reports 
To create a user-defined report, follow the Define a New Report Format instructions in the 
StarShip User's Guide. 

See Also: 
StarShip Overview 
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Frequently Asked Questions About StarShip 
Following are frequently asked questions and answers about using StarShip. 

Question: 

Under what conditions will StarShip transmit an order as COD? 

Answer: 

StarShip will transmit an order as COD under the following conditions: 

• Terms of COD on the order. 

• Customer is marked as "Always COD" in the Credit screen. 

• Customer is over credit limit, and customer is marked as COD when credit limit 
exceeded. 

Question: 

Why am I having difficulty printing FedEx labels? 

Answer: 

To resolve this problem, do the following: 

1. Create a text file named un.txt with the following content: 

N 

UN 

P1 
2. Copy the un.txt file to your C:/ drive on the StarShip workstation. 

3. From a DOS prompt, type the following command: 

C:/copy un.txt lpt1 
This sends the command to the printer and should resolve the problem. 

See Also: 

StarShip Overview 
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